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Introduction

In this example, the High Mach Number Flow, Low Reynolds Number k-ε interface is 
used to compute the compressible turbulent flow from a rectangular nozzle. Mesh 
refinement based on an estimation of the shock strength and the shear-layer strength is 
employed to achieve the appropriate resolution. The emerging turbulent supersonic jet has 
a shock diamond structure that attenuates along its axis due to growing turbulence 
viscosity. The asymmetry of the jet pattern between the minor and the major planes, and 
the entrainment of the surrounding low-speed flow are visualized.

Model Definition

High-speed turbulent flows occur in many cases of academic and practical interest: flow 
around supersonic and hypersonic vehicles as well as flow in rocket nozzles, ramjets, 
scramjets, and supersonic ejectors. This 3D model simulates a turbulent air flow from a 
supersonic nozzle into a large region with slow coflow.

Figure 1: The geometry of the rectangular nozzle (air domain).
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The idea of the geometry of the nozzle was presented in Ref. 1. The exact dimensions are 
not followed here; for example, this model uses blunter edges of the nozzle exit. In this 
study, only a stationary solution is computed, so it is sufficient to consider one quarter of 
the whole geometry; Figure 1 shows the corresponding air domain inside the nozzle. The 
major axis (in the horizontal plane) has a constant width, while the minor axis (in the 
vertical plane) has a convergent–divergent form. The inlet-to-throat area ratio of the 
nozzle is 26/11, while the exit-to-throat area ratio is 13/11. According to quasi-one-
dimensional isentropic relations for a perfect gas with γ = 1.4, the Mach number at the 
throat is unity, Ma = 1, while Ma = 0.2545 at the nozzle inlet and Ma = 1.5083 at the 
nozzle exit. Also, the relations indicate that the ratio of the pressures at the inlet and exit 
of the nozzle is 3.5518. Assuming that the ambient pressure is 1 atm, a static pressure at 
the inlet pin lower than 3.55 atm (approximately, due to deviations from isentropicity and 
quasi-one-dimensionality) would result in overexpanded conditions, while pin larger than 
that value would result in underexpanded conditions. Both situations are characterized by 
remarkable flow patterns consisting of shock and expansion waves enveloped by 
developing shear layers, which dominate further downstream, and slowly entraining flow.

Figure 2: The whole computational geometry with boundary conditions.
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Figure 3: Mesh 2.

Figure 2 shows the boundary conditions for the model. At the nozzle inlet and at the low-
speed co-inlet (coflow makes the computations more robust) total conditions are used. 
Here, a strongly underexpanded case with ptot,in = 10 atm is analyzed. The total pressure 
at the inlet is Ttot,in = 300 K. The computational domain is large enough to ensure that 
the boundaries have little influence on the jet and to capture the entrainment correctly.

Implementation in COMSOL Multiphysics

Study 1, using the relatively coarse Mesh 1, ramps up the inlet total pressure from 
ptot,in = 1.01 atm to ptot,in = 10 atm in 10 steps. Each step takes 7 iterations only, since 
attaining convergence of those intermediate solutions is not of interest. Notice that the 
number of steps and the iterations per step can be varied depending on the convergence 
sensitivity on a particular computer architecture. Then, the mesh shown in Figure 3 and 
Figure 4 is built. Mesh 2 is sufficiently fine to resolve the evolution within the nozzle and 
in its close proximity. The large far-field region, which surrounds the nozzle and the jet 
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regions, is kept coarse. The jet region is meshed quite well but not sufficiently well to 
capture shock waves, and is called the Refinement domain.

Figure 4: Mesh 2 from another view.

Indeed, without prior knowledge of the shock-wave pattern, an excessively fine mesh that 
covers most of the jet region would be required to guarantee resolution of the shocks. To 
avoid this, a shock indicator from Ref. 2 is employed by the adaptive mesh refinement 
strategy, which is limited to the refinement domain. Study 2 uses the last solution of 
Study 1 as the initial value, and starts by obtaining a solution on Mesh 2. This refinement 
level-0 solution is used to perform the error estimation based on a modified (to include 
the shear layers) indicator, and a level-1 adapted mesh is built. The refinement level-1 
solution obtained on this mesh is used to perform the error estimation based on the shock 
indicator. A level-2 adapted mesh is produced and the refinement level-2 solution is 
obtained, which is considered as the final result that is presented below in 2D and 3D 
images (since further refinements using this form of the shock indicator lead to excessively 
large number of elements). Figure 5 shows the mesh evolution through the refinements.

Study 2 uses nondefault settings in the segregated solver that were found to be more 
suitable for this particular problem compared to the default settings.

The results in the far-field region with a coarse mesh are not very reliable. Nevertheless, it 
is expected that entrainment by that part of the jet which is inside the refinement domain 
would be captured correctly.
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Figure 5: Adaptive mesh refinement on the Refinement domain: top — original Mesh 2, 
Middle — shear layers and shock regions refined (Level 1 Adapted Mesh); bottom — shock 
regions refined (Level 2 Adapted Mesh).

The above shock error indicator focuses mostly on the strongest shocks. An improved 
approach is needed to arrive at a more homogeneous refinement of all the shocks.

The details of the implementation for the High Mach Number Flow, Low Reynolds 
Number k-ε interface and of the Adaptation and Error Estimates can be found in the CFD 
Module User’s Guide; see the sections Theory for the High Mach Number Flow 
Interfaces, Theory for the Turbulent Flow Interfaces, Adaptive Mesh Refinement 
(Stationary and Eigenvalue Adaptation), and Error Estimation — Theory and Variables.
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Results and Discussion

Figure 6: Asymmetry between the vertical plane (minor axis) and horizontal plane (major 
axis). Color legends are found in the model file. Bottom: light gray regions — expansion 
regions; dark regions — compression regions.

The three-dimensional perspective of the jet, Figure 6, demonstrates the asymmetry 
between the vertical (minor axis) and horizontal (major axis) planes of the model. The 
Mach disk, possessed by the first shock diamond, can be seen on the “convergent-
divergent plane” (vertical, or minor axis) only. It is not a real normal shock, since the flow 
remains supersonic on passing it. Very strong maximum of the cross-stream velocity is 
observed in the “constant-width plane” (horizontal, or major axis) near the Mach disk. On 
the bottom part of Figure 6 the regions of expansion and compression are clearly visible. 
Shock waves are formed already in the nozzle during the expansion (thus violating 
isentropic conditions and quasi one-dimensionality). The first and the second shock 
diamonds reveal striking asymmetry, but the subsequent shock diamonds become more 
and more symmetric.

The asymmetry between the planes is also illustrated by the two-dimensional perspective 
in Figure 7. The structure of the shock diamonds becomes more symmetric along the axis 
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of the jet, it also becomes smeared out. The vorticity generated by the structure adherent 
to the Mach disk is comparable to the maximum vorticity in the shear layers, but is very 
localized. Observe that at the nozzle exit the temperature is already as low as 200 K, and 
that a very low temperature, 83 K, is achieved just upstream of the Mach disk.

Figure 7: Asymmetry between the vertical and horizontal planes — planar perspective. Above 
the dividing lines Q vertical (minor axis) surface; below the dividing lines — horizontal 
(major axis) surface.

Inspect the model file to observe how the details of the solution on Figure 6 and Figure 7 
change when going from Refinement level 0 to Refinement level 1 to Refinement level 2. 
For example, the first and the second shock diamonds are much sharper in Refinement 2 
than in Refinement 1, while Refinement 0 produces rather diffuse shock diamonds.

Figure 8 demonstrates the evolution of Mach number along the jet axis. Mach number at 
the nozzle exit is close to the above estimated value. Strong expansion follows (since the 
conditions are underexpanded), so that Ma = 3.6 is reached, then a Mach disk occurs with 
Ma = 1.1 behind it. Several more expansion-compression cycles happen. Notice that 
adaptive refinements “pull” the pattern closer to the nozzle compared to the No 
refinement solution, and that difference between Refinement 1 and Refinement 2 is 
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insignificant. This would indicate the mesh convergence, however keep in mind that 
further refinement would produce sharper peaks and troughs in Figure 8.

Figure 9 plots the evolution of the decimal logarithm of the velocity divergence along the 
jet axis. It is clearly seen that at least two shock diamonds (in the tail of the wave dominated 
portion of the jet) are “lost” due to refinements. Indeed, it can be shown that the 
refinements consistently make turbulent viscosity higher, leading to faster smearing of the 
shock diamond structure. Figure 10 plots the evolution of pressure along the jet axis and 
the attenuation observed is consistent with the previous figures. A very low pressure, 
0.117 atm, is achieved just upstream of the Mach disk (at the maximum Mach number), 
while the peak pressure just behind the Mach disk is 2.9 atm, which is higher than at the 
nozzle exit, 2.3 atm.

Figure 8: Mach number along the jet axis. Ye is the distance along the jet axis normalized by 
the equivalent diameter of the nozzle De. Zero point is set exactly at the nozzle exit. No 
refinement corresponds to solution on Mesh 2.
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Figure 9: Velocity divergence at the axis of the jet. See description of Figure 8.

Figure 10: Pressure at the axis of the jet. See description of Figure 8.
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Figure 11: Turbulence Reynolds number at the surfaces of the Refinement domain.

Figure 11 shows the turbulence Reynolds number, equal to the ratio of the turbulence and 
the dynamics viscosities. The picture confirms that when the turbulence generated by the 
shear layers becomes significant, it destroys the shock-diamond pattern. Notice that the 
shock diamonds are able to generate quite high turbulence with large values of the 
turbulence Reynolds number, but those “turbulent patches” are rather localized and 
quickly attenuate. Figure 11 essentially illustrates the main reason of quite fast transition 
from a supersonic jet dominated by inviscid wave phenomena (compression and expansion 
waves) and small influence of turbulence to a “normal” subsonic jet dominated by the 
turbulence effects.
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Figure 12: Supersonic jet envelope — the enveloping surface with Ma = 1.

Figure 12 illustrates the supersonic jet envelope. It is remarkable that even local subsonic 
patches inside the envelope are absent, so that flow can be distinctly subdivided into 
subsonic and supersonic regions. This further confirms that there are no normal shock 
waves inside the jet. After the shock diamond pattern becomes smeared out by the 
growing viscosity, the flow of this supersonic part becomes weakly expanding, which is 
confirmed by Figure 9. The pronounced wave pattern in the beginning of the envelope is 
highly asymmetric and full of details, but when the wave pattern disappears, the cross 
sections of the envelope quickly approach circular profiles.
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Figure 13: Shock diamond isosurfaces Ma = const; the set at the image is [2,0.125,3.5].

Figure 13 shows the Mach number isosurfaces of the first three shock diamonds. The 
structure is very deformed, it possesses very elongated and sharp features. This is in sharp 
contrast with Refinement level-0 version of the image. Look into the model file to see how 
the choice of the Refinement level effects the isosurfaces (try also different sets of 
isosurfaces). Remark that the resolved shock diamond structure looks, in some sense, more 
irregular versus the underresolved case. Thus, a simple visual inspection may help to 
estimate the chosen mesh accuracy in a particular computation of a shock diamond wave 
pattern.
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Figure 14: The streamline pattern. Top - minor axis (convergent-divergent cross section of the 
nozzle) vertical plane, bottom - major axis (constant width cross section of the nozzle) 
horizontal plane.Bright colors - jet flow, calm colors - entrainment flow.

Figure 14 demonstrates the streamlines in the jet and the entrained flow. Quite 
remarkably, the jet flow has a strong tendency to concentrate in the near-axis region. An 
especially sharp deviation is revealed in the horizontal plane, where nearly half of all the 
streamlines very quickly are collected in a very thin region near the axis. This strong 
deviation of the streamlines in the horizontal plane corresponds to very high cross-stream 
velocity in the middle of Figure 6 and is caused by the Mach disk. Zoom out Figure 14 in 
the model file and notice that the initial waviness of the jet/entrainment boundary evolves 
into straight lines. This again illustrates the transition from the pattern with dominant 
shock diamonds to the pattern of the turbulence dominated subsonic jet.

Summary and Outlook

To summarize, the COMSOL Multiphysics computations are able to reveal main features 
of the high-speed jet flow with highly asymmetric structure due to the nozzle geometry, 
both in the supersonic and subsonic portions. The importance of a proper refinement 
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strategy to avoid excessively large meshes while still being able to resolve shock waves as 
well as shear layers is demonstrated.

Various nozzle geometries in underexpanded or overexpanded conditions can be analyzed 
and different approaches to refinement can be tested.

Only consistent stabilization is used in this study, and the target CFL number for pseudo 
time stepping is 10000. In the case of a very sensitive model, inconsistent stabilization or 
a lower target CFL number can be tried to achieve a stationary solution, although the 
relevance of such a solution must be justified in each particular case.

References

1. K. Bhide, K. Siddappaji, and S. Abdallah “Influence of Fluid–Thermal–Structural 
Interaction on Boundary Layer Flow in Rectangular Supersonic Nozzles,” Aerospace, 
vol. 5, p. 33, 2018; doi.org/10.3390/aerospace5020033; copyright 2018 by the authors. 
Licensee MDPI, Basel, Switzerland. This article is an open access article distributed under 
the terms and conditions of the Creative Commons Attribution (CC BY) license 
(creativecommons.org/licenses/by/4.0/).

2. D. Moro, N.C. Nguyen, and J. Peraire, “Dilation-based shock capturing for high-order 
methods,” Int. J. Numer. Methods Fluids, vol. 82, no. 7), pp. 398–416, 2016.

Application Library path: CFD_Module/High_Mach_Number_Flow/
rectangular_nozzle

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Fluid Flow > High Mach Number Flow > Turbulent Flow > 
High Mach Number Flow, Low Reynolds Number k-ε (hmnf).

3 Click Add.
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4 Click Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces > 
Stationary with Initialization.

6 Click Done.

G E O M E T R Y  1

1 Click the Show More Options button in the Model Builder toolbar.

2 In the Show More Options dialog, click Select All.

3 Click OK.

G L O B A L  D E F I N I T I O N S

Parameters 1
1 From the File menu, choose Save As.

2 Browse to a suitable folder, enter the filename rectangular_nozzle.mph, and then 
click Save.

3 In the Model Builder window, under Global Definitions click Parameters 1.

4 In the Settings window for Parameters, locate the Parameters section.

5 Click Load from File.

6 Browse to the model’s Application Libraries folder and double-click the file 
rectangular_nozzle_parameters1.txt.

Load two parameter files with geometric and physical parameters.

Parameters 2
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
rectangular_nozzle_parameters2.txt.

D E F I N I T I O N S

Before setting up the geometry, create three View nodes for later use in image export.

View 2
In the Model Builder window, under Component 1 (comp1) right-click Definitions and 
choose View.
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View 3
In the Model Builder window, right-click View 2 and choose Duplicate.

View 4
In the Model Builder window, right-click View 3 and choose Duplicate.

G E O M E T R Y  1

It suffices to create a quarter of the full geometry due to symmetry.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

Work Plane Major Axis
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane Major Axis in the Label text 
field.

3 Locate the Plane Definition section. From the Plane list, choose zy-plane.

Work Plane Major Axis (wp1) > Plane Geometry
1 In the Model Builder window, click Plane Geometry.

2 In the Settings window for Plane Geometry, locate the Visualization section.

3 Select the View work plane geometry in 3D checkbox.

Work Plane Major Axis (wp1) > Rectangle 1 (r1)
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type w_ba_ma/2+w_a.

4 In the Height text field, type h_tot.

Work Plane Major Axis (wp1) > Rectangle 2 (r2)
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type w_ma/2.

4 In the Height text field, type h_tot.

Work Plane Major Axis (wp1) > Polygon 1 (pol1)
1 In the Work Plane toolbar, click Polygon.

2 In the Settings window for Polygon, locate the Coordinates section.
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3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
rectangular_nozzle_polygon1.txt.

Work Plane Major Axis (wp1) > Difference 1 (dif1)
1 In the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 Select the object r1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Click to select the Activate Selection toggle button for Objects to subtract.

5 Select the objects pol1 and r2 only.

6 In the Work Plane toolbar, click Build All.

Work Plane Minor Axis
1 In the Model Builder window, right-click Geometry 1 and choose Work Plane.

2 In the Settings window for Work Plane, type Work Plane Minor Axis in the Label text 
field.

Work Plane Minor Axis (wp2) > Plane Geometry
1 In the Model Builder window, click Plane Geometry.

2 In the Settings window for Plane Geometry, locate the Visualization section.

3 Select the View work plane geometry in 3D checkbox.

Work Plane Minor Axis (wp2) > Rectangle 1 (r1)
1 In the Work Plane toolbar, click Rectangle.

2 In the Settings window for Rectangle, locate the Size and Shape section.

3 In the Width text field, type w_ba_mi/2+w_a.

4 In the Height text field, type h_tot.

Work Plane Minor Axis (wp2) > Polygon 1 (pol1)
1 In the Work Plane toolbar, click Polygon.

2 In the Settings window for Polygon, locate the Coordinates section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
rectangular_nozzle_polygon2.txt.

Work Plane Minor Axis (wp2) > Polygon 2 (pol2)
1 In the Work Plane toolbar, click Polygon.
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2 In the Settings window for Polygon, locate the Coordinates section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
rectangular_nozzle_polygon3.txt.

Work Plane Minor Axis (wp2) > Difference 1 (dif1)
1 In the Work Plane toolbar, click Booleans and Partitions and choose Difference.

2 Select the object r1 only.

3 In the Settings window for Difference, locate the Difference section.

4 Click to select the Activate Selection toggle button for Objects to subtract.

5 Select the objects pol1 and pol2 only.

6 In the Work Plane toolbar, click Build All.

Extrude Major Axis
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Extrude Major Axis in the Label text field.

3 Locate the General section. From the Work plane list, choose 
Work Plane Major Axis (wp1).

4 Select the object wp1 only.

5 Locate the Distances section. In the table, enter the following settings:

6 Select the Reverse direction checkbox.

Extrude Minor Axis
1 In the Geometry toolbar, click Extrude.

2 In the Settings window for Extrude, type Extrude Minor Axis in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

4 Click Build All Objects.

Union 1 (uni1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

Distances (mm)

w_ba_mi/2+w_a

Distances (mm)

w_ba_ma/2+w_a
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2 Click in the Graphics window and then press Ctrl+A to select both objects.

3 In the Settings window for Union, locate the Selections of Resulting Entities section.

4 Find the Cumulative selection subsection. Click New.

5 In the New Cumulative Selection dialog, type Nozzle_mold in the Name text field.

6 Click OK.

Delete Entities 1 (del1)
1 Right-click Geometry 1 and choose Delete Entities.

2 In the Settings window for Delete Entities, locate the Entities or Objects to Delete 
section.

3 From the Geometric entity level list, choose Domain.

4 On the object uni1, select Domains 4 and 5 only.

5 Click Build All Objects.

Linking Domain
1 In the Geometry toolbar, click Block.

2 In the Settings window for Block, type Linking Domain in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 0.8*w_mi_t.

4 In the Depth text field, type 0.2*(h_tot-h_mi_mt).

5 In the Height text field, type 0.6*w_ma.

6 Locate the Position section. In the y text field, type h_tot-0.1*(h_tot-h_mi_mt).

7 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

8 In the New Cumulative Selection dialog, type Linking in the Name text field.

9 Click OK.

Create the domain on which adaptive mesh refinement will be applied.

Work Plane, Refinement Cross Section
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, type Work Plane, Refinement Cross 
Section in the Label text field.

3 Locate the Plane Definition section. From the Plane list, choose zx-plane.

4 In the y-coordinate text field, type h_tot+0.1*(h_tot-h_mi_mt).
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Work Plane, Refinement Cross Section (wp3) > Plane Geometry
1 In the Model Builder window, click Plane Geometry.

2 In the Settings window for Plane Geometry, locate the Visualization section.

3 Select the View work plane geometry in 3D checkbox.

Work Plane, Refinement Cross Section (wp3) > Ellipse 1 (e1)
1 In the Work Plane toolbar, click Ellipse.

2 In the Settings window for Ellipse, locate the Size and Shape section.

3 In the a-semiaxis text field, type 2*w_ma.

4 In the b-semiaxis text field, type 5*w_mi_t.

5 In the Sector angle text field, type 90.

Refinement Domain
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Refinement Domain in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

4 Locate the Selections of Resulting Entities section. Find the Cumulative selection 
subsection. Click New.

5 In the New Cumulative Selection dialog, type Refinement in the Name text field.

6 Click OK.

Cutting Domain
1 In the Geometry toolbar, click Block.

2 In the Settings window for Block, type Cutting Domain in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type w_mi_b/2.

4 In the Depth text field, type h_mi_ml-(h_mi_mt-h_mi_ml)/4.

5 In the Height text field, type w_ma/2.

Create a large computational domain to reduce the influence of boundary conditions on 
the jet and to obtain the correct amount of entrainment.

Work Plane, Computational Cross Section
1 In the Geometry toolbar, click Work Plane.

Distances (mm)

6*h_tot
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2 In the Settings window for Work Plane, type Work Plane, Computational Cross 
Section in the Label text field.

3 Locate the Plane Definition section. From the Plane list, choose zx-plane.

Work Plane, Computational Cross Section (wp4) > Plane Geometry
In the Model Builder window, click Plane Geometry.

Work Plane, Computational Cross Section (wp4) > Circle 1 (c1)
1 In the Work Plane toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type sqrt(uc_wa_h*uc_wa_w).

4 In the Sector angle text field, type 90.

Computational Domain
1 In the Model Builder window, right-click Geometry 1 and choose Extrude.

2 In the Settings window for Extrude, type Computational Domain in the Label text field.

3 Locate the Distances section. In the table, enter the following settings:

Difference 1 (dif1)
1 In the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 Select the objects blk1, ext3, and ext4 only.

3 In the Settings window for Difference, locate the Difference section.

4 Click to select the Activate Selection toggle button for Objects to subtract.

5 Select the objects blk2 and del1 only.

6 Click Build All Objects.

Work Plane 5 (wp5)
1 In the Geometry toolbar, click Work Plane.

2 In the Settings window for Work Plane, locate the Plane Definition section.

3 From the Plane list, choose zx-plane.

4 In the y-coordinate text field, type h_mi_mt-(h_mi_mt-h_mi_ml)/8.

Partition Domains 1 (pard1)
1 In the Geometry toolbar, click Booleans and Partitions and choose 

Partition Domains.

Distances (mm)

H_tot
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2 On the object dif1, select Domain 2 only.

3 In the Settings window for Partition Domains, click Build All Objects.

Disable the analysis of the geometry as the remaining small geometric details can be 
kept.

4 In the Model Builder window, click Geometry 1.

5 In the Settings window for Geometry, locate the Cleanup section.

6 Clear the Automatic detection of small details checkbox.

Create predefined selections for later use.

D E F I N I T I O N S

Inlet
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.

3 From the Geometric entity level list, choose Boundary.

4 In the Label text field, type Inlet.

5 Select Boundary 8 only.

Co-Inlet
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Co-Inlet in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundary 2 only.

Outlet
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Outlet in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundary 30 only.

No-Slip Wall, Coarse Mesh
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.

3 From the Geometric entity level list, choose Boundary.

4 In the Label text field, type No-Slip Wall, Coarse Mesh.
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5 Select Boundaries 3, 5, 6, 33, 41, 42, 44, 45, and 47–51 only.

No-Slip Wall, Fine Mesh
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type No-Slip Wall, Fine Mesh in the Label text 
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, select Nozzle_mold in the Selections to add list.

6 Click OK.

7 In the Settings window for Difference, locate the Input Entities section.

8 Under Selections to subtract, click Add.

9 In the Add dialog, select No-Slip Wall, Coarse Mesh in the Selections to subtract list.

10 Click OK.

Slip Wall
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Slip Wall in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundary 4 only.

Symmetry Boundary
1 In the Definitions toolbar, click Complement.

2 In the Settings window for Complement, type Symmetry Boundary in the Label text 
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to invert, click Add.

5 In the Add dialog, in the Selections to invert list, choose Inlet, Co-Inlet, Outlet, No-

Slip Wall, Coarse Mesh, No-Slip Wall, Fine Mesh, and Slip Wall.

6 Click OK.

Nozzle 1
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Nozzle 1 in the Label text field.

3 Select Domain 2 only.
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Nozzle 2
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Nozzle 2 in the Label text field.

3 Select Domains 3 and 4 only.

Nozzle+Linking+Refinement
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Nozzle+Linking+Refinement in the Label text 
field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Nozzle 1, Nozzle 2, and Refinement.

5 Click OK.

Refinement Edge
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Refinement Edge in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Edge.

4 Select Edge 34 only.

Main-Region Boundaries
1 In the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, type Main-Region Boundaries in the Label text 
field.

3 Locate the Input Entities section. Under Input selections, click Add.

4 In the Add dialog, select Nozzle+Linking+Refinement in the Input selections list.

5 Click OK.

Vertical Plane
1 In the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Vertical Plane in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundaries 9, 13, 17, and 25 only.

Vertical Extended Plane
1 Right-click Vertical Plane and choose Duplicate.

2 In the Settings window for Explicit, type Vertical Extended Plane in the Label text 
field.
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3 Select Boundaries 9, 13, 17, 25, and 29 only.

Horizontal Plane
1 Right-click Vertical Extended Plane and choose Duplicate.

2 In the Settings window for Explicit, type Horizontal Plane in the Label text field.

3 Locate the Input Entities section. Click Remove from Selection.

4 Click Clear Selection.

5 Select Boundaries 7, 11, 15, and 23 only.

Horizontal Extended Plane
1 Right-click Horizontal Plane and choose Duplicate.

2 In the Settings window for Explicit, type Horizontal Extended Plane in the Label text 
field.

3 Select Boundaries 1, 7, 11, 15, and 23 only.

Vertical+Horizontal Planes
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Vertical+Horizontal Planes in the Label text 
field.

3 Locate the Geometric Entity Level section. From the Level list, choose Boundary.

4 Locate the Input Entities section. Under Selections to add, click Add.

5 In the Add dialog, in the Selections to add list, choose Vertical Plane and Horizontal Plane.

6 Click OK.

A D D  M A T E R I A L

1 In the Materials toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-in > Air.

4 Click the Add to Component button in the window toolbar.

5 In the Materials toolbar, click Add Material to close the Add Material window.

H I G H  M A C H  N U M B E R  F L O W ,  L O W  R E Y N O L D S  N U M B E R  K - ε ( H M N F )

1 In the Settings window for High Mach Number Flow, Low Reynolds Number k-ε, locate the 
Physical Model section.

2 In the Tref text field, type T_in.

3 Click to expand the Advanced Settings section.
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Fluid 1
1 In the Model Builder window, under Component 1 (comp1) > High Mach Number Flow,

Low Reynolds Number k-ε (hmnf) click Fluid 1.

2 In the Settings window for Fluid, locate the Heat Conduction section.

3 From the k list, choose From material.

4 Locate the Dynamic Viscosity section. From the μ list, choose From material.

Initial Values 1
1 In the Model Builder window, click Initial Values 1.

2 In the Settings window for Initial Values, locate the Initial Values section.

3 In the T text field, type T_in.

Inlet 1
1 In the Physics toolbar, click Boundaries and choose Inlet.

Apply total conditions at the jet inlet.

2 In the Settings window for Inlet, locate the Boundary Selection section.

3 From the Selection list, choose Inlet.

4 Locate the Flow Properties section. From the Input state list, choose Total.

5 In the p0,tot text field, type p_in.

6 In the T0,tot text field, type T_in.

7 In the Ma0 text field, type Ma_in.

Create an inlet with low-speed co-flow to make computations more stable.

Inlet 2
1 In the Physics toolbar, click Boundaries and choose Inlet.

2 In the Settings window for Inlet, locate the Boundary Selection section.

3 From the Selection list, choose Co-Inlet.

4 Locate the Flow Properties section. From the Input state list, choose Total.

5 In the T0,tot text field, type T_in.

6 In the Ma0 text field, type Ma_co.

Outlet 1
1 In the Physics toolbar, click Boundaries and choose Outlet.

The outlet is placed far enough downstream so that subsonic conditions with 
atmospheric pressure can be applied.
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2 In the Settings window for Outlet, locate the Boundary Selection section.

3 From the Selection list, choose Outlet.

4 Locate the Flow Condition section. From the Flow condition list, choose Subsonic.

Wall 2
1 In the Physics toolbar, click Boundaries and choose Wall.

The far-field boundary can be treated as a slip wall.

2 In the Settings window for Wall, locate the Boundary Selection section.

3 From the Selection list, choose Slip Wall.

4 Locate the Boundary Condition section. From the Wall condition list, choose Slip.

Symmetry 1
1 In the Physics toolbar, click Boundaries and choose Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose Symmetry Boundary.

A relatively coarse Mesh 1 is used for ramping up the inlet pressure to a relatively high value.

M E S H  1

1 In the Model Builder window, under Component 1 (comp1) click Mesh 1.

2 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

3 From the Element size list, choose Extra coarse.

Size 1
Right-click Component 1 (comp1) > Mesh 1 and choose Size.

Size
1 In the Settings window for Size, locate the Element Size section.

2 From the Calibrate for list, choose Fluid dynamics.

Size 1
1 In the Model Builder window, click Size 1.

2 In the Settings window for Size, locate the Element Size section.

3 From the Calibrate for list, choose Fluid dynamics.

4 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Boundary.

5 From the Selection list, choose No-Slip Wall, Fine Mesh.

6 Locate the Element Size section. From the Predefined list, choose Finer.
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Size 2
1 In the Model Builder window, right-click Mesh 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Edge.

4 From the Selection list, choose Refinement Edge.

5 Locate the Element Size section. From the Calibrate for list, choose Fluid dynamics.

6 From the Predefined list, choose Extremely fine.

7 Click the Custom button.

8 Locate the Element Size Parameters section.

9 Select the Maximum element size checkbox. In the associated text field, type 4.

Size 3
1 Right-click Mesh 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Nozzle+Linking+Refinement.

5 Locate the Element Size section. From the Calibrate for list, choose Fluid dynamics.

6 From the Predefined list, choose Finer.

7 Click the Custom button.

8 Locate the Element Size Parameters section.

9 Select the Maximum element growth rate checkbox. In the associated text field, type 
1.05.

Free Tetrahedral 1
In the Mesh toolbar, click Free Tetrahedral.

Boundary Layers 1
1 In the Mesh toolbar, click Boundary Layers.

2 In the Settings window for Boundary Layers, click to expand the Corner Settings section.

3 In the Split for angles greater than text field, type 270.

Boundary Layer Properties
1 In the Model Builder window, click Boundary Layer Properties.

2 In the Settings window for Boundary Layer Properties, locate the 
Geometric Entity Selection section.

3 From the Selection list, choose No-Slip Wall, Fine Mesh.
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4 Locate the Layers section. In the Number of layers text field, type 6.

Boundary Layer Properties 1
1 Right-click Boundary Layer Properties and choose Duplicate.

2 In the Settings window for Boundary Layer Properties, locate the Boundary Selection 
section.

3 From the Selection list, choose No-Slip Wall, Coarse Mesh.

4 In the Model Builder window, right-click Mesh 1 and choose Build All.

Study 1 is used to ramp up the inlet total pressure to 10[atm] using an auxiliary sweep. 
This way, initial values for further computations on finer meshes are quickly obtained.

S T U D Y  1

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, locate the Study Settings section.

3 Clear the Generate default plots checkbox.

Step 2: Stationary
1 In the Model Builder window, under Study 1 click Step 2: Stationary.

2 In the Settings window for Stationary, click to expand the Study Extensions section.

3 Select the Auxiliary sweep checkbox.

4 Click Add.

5 In the table, enter the following settings:

Solution 1 (sol1)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node.

Take only seven iterations in each step of the auxiliary sweep, since intermediate 
converged solutions on the coarse mesh are not of interest.

3 In the Model Builder window, expand the Study 1 > Solver Configurations > 
Solution 1 (sol1) > Stationary Solver 2 node, then click Segregated 1.

4 In the Settings window for Segregated, locate the General section.

5 From the Termination technique list, choose Iterations or tolerance.

Parameter name Parameter value list Parameter unit

p_in 1.01 1.1 1.25 1.5 2 3 range(4,2,
10)

atm
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6 In the Number of iterations text field, type 7.

Set up a hybrid preconditioner with velocity and pressure in Multigrid 1 and temperature 
in Multigrid 2, to ensure convergence for computations on many cores.

7 In the Model Builder window, expand the Study 1 > Solver Configurations > 
Solution 1 (sol1) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) node, then click 
Multigrid 1.

8 In the Settings window for Multigrid, click to expand the Hybridization section.

9 From the Use as list, choose Multi preconditioner.

10 In the Preconditioner variables list, choose Turbulent Dissipation Rate (comp1.ep), 
Reciprocal Wall Distance (comp1.G), Wall Temperature, Downside (comp1.hmnf.TWall_d), 
Wall Temperature, Upside (comp1.hmnf.TWall_u), Turbulent Kinetic Energy (comp1.k), 
and Temperature (comp1.T).

11 Under Preconditioner variables, click Delete.

12 In the Model Builder window, under Study 1 > Solver Configurations > Solution 1 (sol1) > 
Stationary Solver 2 right-click AMG, fluid flow variables (hmnf) and choose Multigrid.

Multigrid 2 uses settings that are default for the turbulence variables.

13 In the Settings window for Multigrid, locate the General section.

14 From the Solver list, choose Smoothed aggregation AMG.

15 In the Maximum number of DOFs at coarsest level text field, type 50000.

16 Select the Construct prolongators componentwise checkbox.

17 Clear the Prolongator smoothing checkbox.

18 Locate the Hybridization section. In the Preconditioner variables list, choose 
Turbulent Dissipation Rate (comp1.ep), Reciprocal Wall Distance (comp1.G), 
Turbulent Kinetic Energy (comp1.k), Pressure (comp1.p), and Velocity Field (comp1.u).

19 Under Preconditioner variables, click Delete.

20 In the Model Builder window, expand the Study 1 > Solver Configurations > 
Solution 1 (sol1) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) > Multigrid 2 > 
Presmoother node.

21 Right-click Study 1 > Solver Configurations > Solution 1 (sol1) > Stationary Solver 2 > 
AMG, fluid flow variables (hmnf) > Multigrid 2 > Presmoother and choose SOR Line.

22 In the Settings window for SOR Line, locate the Main section.

23 From the Sweep type list, choose SSOR.

24 In the Number of iterations text field, type 0.
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25 In the Relaxation factor text field, type 0.7.

26 From the Multivariable method list, choose Uncoupled.

27 Locate the Secondary section. In the Relaxation factor text field, type 0.5.

28 In the Model Builder window, expand the Study 1 > Solver Configurations > 
Solution 1 (sol1) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) > Multigrid 2 > 
Postsmoother node.

29 Right-click Study 1 > Solver Configurations > Solution 1 (sol1) > Stationary Solver 2 > 
AMG, fluid flow variables (hmnf) > Multigrid 2 > Postsmoother and choose SOR Line.

30 In the Settings window for SOR Line, locate the Main section.

31 From the Sweep type list, choose SSOR.

32 In the Number of iterations text field, type 1.

33 In the Relaxation factor text field, type 0.7.

34 From the Multivariable method list, choose Uncoupled.

35 Locate the Secondary section. In the Relaxation factor text field, type 0.5.

36 In the Model Builder window, expand the Study 1 > Solver Configurations > 
Solution 1 (sol1) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) > Multigrid 2 > 
Coarse Solver node.

37 Right-click Study 1 > Solver Configurations > Solution 1 (sol1) > Stationary Solver 2 > 
AMG, fluid flow variables (hmnf) > Multigrid 2 > Coarse Solver and choose Direct.

38 In the Settings window for Direct, locate the General section.

39 From the Solver list, choose PARDISO.

40 In the Pivoting perturbation text field, type 1.0E-13.

41 In the Study toolbar, click Compute.

Create an error indicator for adaptive mesh refinement.

D E F I N I T I O N S

Variables 1
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

2 In the Settings window for Variables, locate the Variables section.
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3 In the table, enter the following settings:

At the first refinement level shock regions and shear layers are refined. At the second 
refinement level only shock regions are refined. Use the adaptlevel variable to control 
this.

M E S H  2

1 In the Mesh toolbar, click Add Mesh and choose Add Mesh.

Mesh 2 is constructed so that the nozzle and its close proximity have sufficient 
resolution, and adaptive mesh refinement will be applied only on the Refinement Domain. 
Far-field regions are kept coarse.

2 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

3 From the Element size list, choose Extra coarse.

Size 1
Right-click Mesh 2 and choose Size.

Name Expression Unit Description

dilatation_error_ex
pression

-1.5*h*hmnf.divu/
hmnf.c_s*sqrt((1+
hmnf.gamma)/(2+
(hmnf.gamma-1)*
hmnf.Ma^2))

shock_error_indicat
or

max(dilatation_error_ex
pression,0)

modified_error_indi
cator

1.5*h*(max(-hmnf.divu,
0)+hmnf.sr/10)/
hmnf.c_s*sqrt((1+
hmnf.gamma)/(2+
(hmnf.gamma-1)*
hmnf.Ma^2))

account_strain_infl
uence

adaptlevel<1

custom_error_indica
tor

1.5*h*(max(-hmnf.divu,
0)+
account_strain_influenc
e*hmnf.sr/10)/hmnf.c_s*
sqrt((1+hmnf.gamma)/(2+
(hmnf.gamma-1)*
hmnf.Ma^2))

Y_e (y-h_tot)/D_e
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Size
1 In the Settings window for Size, locate the Element Size section.

2 From the Calibrate for list, choose Fluid dynamics.

3 Click the Custom button.

4 Locate the Element Size Parameters section. In the Maximum element growth rate text 
field, type 1.1.

Size 1
1 In the Model Builder window, click Size 1.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Nozzle 1.

5 Locate the Element Size section. From the Calibrate for list, choose Fluid dynamics.

6 From the Predefined list, choose Extremely fine.

7 Click the Custom button.

8 Locate the Element Size Parameters section.

9 Select the Maximum element size checkbox. In the associated text field, type 0.8.

10 Select the Minimum element size checkbox. In the associated text field, type 0.1.

Size 2
1 In the Model Builder window, right-click Mesh 2 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Nozzle 2.

5 Locate the Element Size section. From the Calibrate for list, choose Fluid dynamics.

6 From the Predefined list, choose Extremely fine.

7 Click the Custom button.

8 Locate the Element Size Parameters section.

9 Select the Maximum element size checkbox. In the associated text field, type 0.3.

10 Select the Minimum element size checkbox. In the associated text field, type 0.06.

Size 3
1 Right-click Mesh 2 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.
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3 From the Geometric entity level list, choose Edge.

4 From the Selection list, choose Refinement Edge.

5 Locate the Element Size section. From the Predefined list, choose Extremely fine.

6 Click the Custom button.

7 Locate the Element Size Parameters section.

8 Select the Maximum element size checkbox. In the associated text field, type 1.

Size 4
1 Right-click Mesh 2 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Domain.

4 From the Selection list, choose Refinement.

5 Locate the Element Size section. From the Calibrate for list, choose Fluid dynamics.

6 From the Predefined list, choose Extremely fine.

7 Click the Custom button.

8 Locate the Element Size Parameters section.

9 Select the Maximum element size checkbox. In the associated text field, type 5.

Free Tetrahedral 1
In the Mesh toolbar, click Free Tetrahedral.

Boundary Layers 1
1 In the Mesh toolbar, click Boundary Layers.

2 In the Settings window for Boundary Layers, locate the Corner Settings section.

3 In the Split for angles greater than text field, type 270.

Boundary Layer Properties
1 In the Model Builder window, click Boundary Layer Properties.

2 In the Settings window for Boundary Layer Properties, locate the 
Geometric Entity Selection section.

3 From the Selection list, choose No-Slip Wall, Fine Mesh.

4 Locate the Layers section. In the Number of layers text field, type 9.

Boundary Layer Properties 1
1 In the Mesh toolbar, click More Attributes and choose Boundary Layer Properties.
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2 In the Settings window for Boundary Layer Properties, locate the Boundary Selection 
section.

3 From the Selection list, choose No-Slip Wall, Coarse Mesh.

4 Locate the Layers section. In the Number of layers text field, type 6.

5 In the Model Builder window, right-click Mesh 2 and choose Build All.

R O O T

Study 2 takes initial values from the last step of Study 1. It starts on the finer Mesh 2 and 
improves it in two refinement steps to properly capture shear layers and shocks. This is 
needed because the exact shock structure is not known in advance, thus a reasonable (not 
excessively large) mesh cannot be built immediately.

A D D  S T U D Y

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Stationary with Initialization.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2

Step 1: Wall Distance Initialization
1 In the Settings window for Wall Distance Initialization, click to expand the 

Values of Dependent Variables section.

2 Find the Initial values of variables solved for subsection. From the Settings list, choose 
User controlled.

3 From the Method list, choose Solution.

4 From the Study list, choose Study 1, Stationary.

5 From the Parameter value (p_in (atm)) list, choose Last.

6 Find the Values of variables not solved for subsection. From the Settings list, choose 
User controlled.

7 From the Method list, choose Solution.

8 From the Study list, choose Study 1, Stationary.

9 From the Parameter value (p_in (atm)) list, choose Last.
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Two levels of adaptive mesh refinement using Error indicator are applied.

Step 2: Stationary
1 In the Model Builder window, click Step 2: Stationary.

2 In the Settings window for Stationary, click to expand the Adaptation and Error Estimates 
section.

3 From the Adaptation and error estimates list, choose Adaptation and error estimates.

4 From the Error estimate list, choose Error indicator.

5 Click Add.

6 In the table, enter the following settings:

7 Find the Mesh adaptation subsection.

8 Select the Maximum number of adaptations checkbox. In the associated text field, type 2.

9 Locate the Geometric Entity Selection for Adaptation section. From the 
Geometric entity level list, choose Domain.

10 From the Selection list, choose Refinement.

11 In the Model Builder window, click Study 2.

12 In the Settings window for Study, locate the Study Settings section.

13 Select the Store complete solver history checkbox.

Solution 3 (sol3)
1 In the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 3 (sol3) node.

3 In the Model Builder window, expand the Study 2 > Solver Configurations > 
Solution 3 (sol3) > Stationary Solver 2 node, then click Adaptive Mesh Refinement.

4 In the Settings window for Adaptive Mesh Refinement, locate the General section.

5 Clear the Allow coarsening checkbox.

6 Find the Mesh adaptation subsection. In the Maximum number of elements text field, 
type 20000000.

Adjust settings in Segregated 1 to achieve fast and smooth convergence. Notice that 
increasing Initial CFL number is not recommended in the general case.

7 In the Model Builder window, under Study 2 > Solver Configurations > Solution 3 (sol3) > 
Stationary Solver 2 click Segregated 1.

Error expression Active

custom_error_indicator √
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8 In the Settings window for Segregated, locate the General section.

9 From the Termination technique list, choose Iterations or tolerance.

10 In the Number of iterations text field, type 120.

11 In the Initial CFL number text field, type 25.

12 In the PID controller - proportional text field, type 0.25.

13 In the PID controller - integral text field, type 0.15.

14 In the PID controller - derivative text field, type 0.15.

15 In the Target error estimate text field, type 0.1.

16 Clear the Adaptive target error estimate checkbox.

17 In the CFL threshold text field, type 9900.

Set up a hybrid preconditioner with velocity and pressure in Multigrid 1 and temperature 
in Multigrid 2, to ensure convergence for computations on many cores.

18 In the Model Builder window, expand the Study 2 > Solver Configurations > 
Solution 3 (sol3) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) node, then click 
Multigrid 1.

19 In the Settings window for Multigrid, locate the Hybridization section.

20 From the Use as list, choose Multi preconditioner.

21 In the Preconditioner variables list, choose Turbulent Dissipation Rate (comp1.ep), 
Reciprocal Wall Distance (comp1.G), Wall Temperature, Downside (comp1.hmnf.TWall_d), 
Wall Temperature, Upside (comp1.hmnf.TWall_u), Turbulent Kinetic Energy (comp1.k), 
and Temperature (comp1.T).

22 Under Preconditioner variables, click Delete.

23 In the Model Builder window, under Study 2 > Solver Configurations > Solution 3 (sol3) > 
Stationary Solver 2 right-click AMG, fluid flow variables (hmnf) and choose Multigrid.

Multigrid 2 uses settings that are default for the turbulence variables.

24 In the Settings window for Multigrid, locate the General section.

25 From the Solver list, choose Smoothed aggregation AMG.

26 In the Maximum number of DOFs at coarsest level text field, type 50000.

27 Select the Construct prolongators componentwise checkbox.

28 Clear the Prolongator smoothing checkbox.

29 Locate the Hybridization section. In the Preconditioner variables list, choose 
Turbulent Dissipation Rate (comp1.ep), Reciprocal Wall Distance (comp1.G), 
Turbulent Kinetic Energy (comp1.k), Pressure (comp1.p), and Velocity Field (comp1.u).
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30 Under Preconditioner variables, click Delete.

31 In the Model Builder window, expand the Study 2 > Solver Configurations > 
Solution 3 (sol3) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) > Multigrid 2 > 
Presmoother node.

32 Right-click Study 2 > Solver Configurations > Solution 3 (sol3) > Stationary Solver 2 > 
AMG, fluid flow variables (hmnf) > Multigrid 2 > Presmoother and choose SOR Line.

33 In the Settings window for SOR Line, locate the Main section.

34 From the Sweep type list, choose SSOR.

35 In the Number of iterations text field, type 0.

36 In the Relaxation factor text field, type 0.7.

37 From the Multivariable method list, choose Uncoupled.

38 Locate the Secondary section. In the Relaxation factor text field, type 0.5.

39 In the Model Builder window, expand the Study 2 > Solver Configurations > 
Solution 3 (sol3) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) > Multigrid 2 > 
Postsmoother node.

40 Right-click Study 2 > Solver Configurations > Solution 3 (sol3) > Stationary Solver 2 > 
AMG, fluid flow variables (hmnf) > Multigrid 2 > Postsmoother and choose SOR Line.

41 In the Settings window for SOR Line, locate the Main section.

42 From the Sweep type list, choose SSOR.

43 In the Number of iterations text field, type 1.

44 In the Relaxation factor text field, type 0.7.

45 From the Multivariable method list, choose Uncoupled.

46 Locate the Secondary section. In the Relaxation factor text field, type 0.5.

47 In the Model Builder window, expand the Study 2 > Solver Configurations > 
Solution 3 (sol3) > Stationary Solver 2 > AMG, fluid flow variables (hmnf) > Multigrid 2 > 
Coarse Solver node.

48 Right-click Study 2 > Solver Configurations > Solution 3 (sol3) > Stationary Solver 2 > 
AMG, fluid flow variables (hmnf) > Multigrid 2 > Coarse Solver and choose Direct.

49 In the Settings window for Direct, locate the General section.

50 From the Solver list, choose PARDISO.

51 In the Pivoting perturbation text field, type 1.0E-13.

52 In the Model Builder window, click Study 2.

53 In the Settings window for Study, locate the Study Settings section.
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54 Clear the Generate default plots checkbox.

55 In the Study toolbar, click Compute.

R E S U L T S

1 In the Model Builder window, click Results.

2 In the Settings window for Results, locate the Update of Results section.

3 Select the Only plot when requested checkbox.

Define parameters for creating bounding boxes for plots.

Parameters
1 In the Results toolbar, click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 In the table, enter the following settings:

Create datasets for 3D and 2D plot groups. Start with the isosurface for the supersonic jet 
envelope.

Isosurface 1
1 In the Results toolbar, click More Datasets and choose Isosurface.

2 In the Settings window for Isosurface, locate the Data section.

3 From the Dataset list, choose Study 2/Adaptive Mesh Refinement Solutions 1 (sol5).

4 Locate the Expression section. In the Expression text field, type hmnf.Ma.

5 Locate the Levels section. From the Entry method list, choose Levels.

6 In the Levels text field, type 1.

Isosurface 2
1 Right-click Isosurface 1 and choose Duplicate.

Specify isosurfaces for a range of Mach numbers.

2 In the Settings window for Isosurface, locate the Levels section.

Name Expression Value Description

L1 0.05[m] 0.05 m

L2 6*h_tot 0.54 m

L3 2.3*L1 0.115 m

L4 0.04[m] 0.04 m

L5 3.5*h_tot 0.315 m
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3 In the Levels text field, type range(2.0,0.125,3.5).

Complement Isosurface 1 using rotation and reflection.

Sector 3D 1
1 In the Results toolbar, click More Datasets and choose Sector 3D.

2 In the Settings window for Sector 3D, locate the Data section.

3 From the Dataset list, choose Isosurface 1.

4 Locate the Axis Data section. In row Point 1, set y to 1.

5 In row Point 2, set z to 0.

6 Locate the Symmetry section. In the Number of sectors text field, type 4.

7 From the Transformation list, choose Rotation and reflection.

Complement Isosurface 2 using rotation and reflection.

Sector 3D 2
1 In the Results toolbar, click More Datasets and choose Sector 3D.

2 In the Settings window for Sector 3D, locate the Data section.

3 From the Dataset list, choose Isosurface 2.

4 Locate the Symmetry section. From the Sectors to include list, choose Manual.

5 In the Start sector text field, type 1.

6 In the Number of sectors to include text field, type 3.

7 Locate the Axis Data section. In row Point 1, set y to 1.

8 In row Point 2, set z to 0.

9 Locate the Symmetry section. In the Number of sectors text field, type 4.

10 From the Transformation list, choose Rotation and reflection.

Create a minor axis (vertical plane) surface.

Surface 1
1 In the Results toolbar, click More Datasets and choose Surface.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Study 2/Adaptive Mesh Refinement Solutions 1 (sol5).

4 Locate the Parameterization section. From the x- and y-axes list, choose yx-plane.

5 Locate the Selection section. From the Selection list, choose Vertical Plane.
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Surface 2
1 Right-click Surface 1 and choose Duplicate.

Create a major axis (horizontal plane) surface.

2 In the Settings window for Surface, locate the Parameterization section.

3 From the x- and y-axes list, choose yz-plane.

4 Locate the Selection section. From the Selection list, choose Horizontal Plane.

Surface 3
1 In the Model Builder window, under Results > Datasets right-click Surface 1 and choose 

Duplicate.

Create a dummy (vertical) surface for creating a cut line to be used as a geometric entity 
in a 2D plot.

2 In the Settings window for Surface, locate the Data section.

3 From the Dataset list, choose Study 1/Solution Store 1 (sol2).

4 Locate the Selection section. From the Selection list, choose Vertical Extended Plane.

Cut Line 2D 1
1 In the Results toolbar, click Cut Line 2D.

2 In the Settings window for Cut Line 2D, locate the Data section.

3 From the Dataset list, choose Surface 3.

4 Locate the Line Data section. In row Point 1, set x to h_tot/2.

5 In row Point 2, set x to L2.

6 Select the Additional parallel lines checkbox.

7 In the Distances text field, type range(L3,L3,2*L3).

Export high-resolution images of the meshes.

Image 1
1 In the Results toolbar, click Image.

2 In the Settings window for Image, choose Presentation and document from the Preset list.

3 Locate the Image section. In the Width text field, type 3165.

4 In the Height text field, type 2374.

5 In the Resolution text field, type 90.

6 Locate the Scene section. In the tree, select Model (root) > Component 1 (comp1) > 
Meshes > Mesh 1.

7 Click Use as Source.
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8 Locate the Output section. From the Target list, choose File.

9 Locate the Scene section. From the View list, choose View 2.

10 Locate the Output section. In the Filename text field, type 
rectangular_nozzle_mesh_1_HiRes.png.

11 Click Export.

Image 2
1 Right-click Image 1 and choose Duplicate.

2 In the Settings window for Image, locate the Scene section.

3 In the tree, select Model (root) > Component 1 (comp1) > Meshes > Mesh 2.

4 Click Use as Source.

5 From the View list, choose View 3.

6 Locate the Output section. In the Filename text field, type 
rectangular_nozzle_mesh_2_HiRes.png.

7 Click Export.

Image 3
1 Right-click Image 2 and choose Duplicate.

2 In the Settings window for Image, locate the Scene section.

3 From the View list, choose View 4.

4 Locate the Output section. In the Filename text field, type 
rectangular_nozzle_mesh_3_HiRes.png.

5 Click Export.

Image 4
1 Right-click Image 3 and choose Duplicate.

2 In the Settings window for Image, locate the Scene section.

3 In the tree, select Model (root) > Component 1 (comp1) > Meshes > 
Level 1 Adapted Mesh 1.

4 Click Use as Source.

5 Locate the Output section. In the Filename text field, type 
rectangular_nozzle_mesh_4_HiRes.png.

6 Click Export.

Image 5
1 Right-click Image 4 and choose Duplicate.
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2 In the Settings window for Image, locate the Scene section.

3 In the tree, select Model (root) > Component 1 (comp1) > Meshes > 
Level 2 Adapted Mesh 2.

4 Click Use as Source.

5 Locate the Output section. In the Filename text field, type 
rectangular_nozzle_mesh_5_HiRes.png.

6 Click Export.

Centerline Mach Number
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Centerline Mach Number in the Label 
text field.

3 Locate the Data section. From the Dataset list, choose Study 2/

Adaptive Mesh Refinement Solutions 1 (sol5).

4 Click to expand the Title section. From the Title type list, choose Label.

5 Locate the Plot Settings section.

6 Select the x-axis label checkbox. In the associated text field, type Y_e.

7 Select the y-axis label checkbox. In the associated text field, type Mach number.

Line Graph 1
1 Right-click Centerline Mach Number and choose Line Graph.

2 Select Edges 11, 16, 21, and 34 only.

3 In the Settings window for Line Graph, locate the y-Axis Data section.

4 In the Expression text field, type hmnf.Ma.

5 Locate the x-Axis Data section. From the Parameter list, choose Expression.

6 In the Expression text field, type Y_e.

7 Click to expand the Legends section. Select the Show legends checkbox.

8 From the Legends list, choose Manual.

9 In the table, enter the following settings:

10 In the Centerline Mach Number toolbar, click Plot.

Legends

No refinement

Refinement 1

Refinement 2
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Centerline Velocity Divergence
1 In the Model Builder window, right-click Centerline Mach Number and choose Duplicate.

2 In the Model Builder window, click Centerline Mach Number 1.

3 In the Settings window for 1D Plot Group, type Centerline Velocity Divergence in 
the Label text field.

4 Locate the Plot Settings section. In the y-axis label text field, type Decimal logarithm 
of velocity divergence.

5 Locate the Legend section. From the Position list, choose Lower right.

Line Graph 1
1 In the Model Builder window, click Line Graph 1.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type sign(hmnf.divu)*log10(abs(hmnf.divu)).

4 In the Centerline Velocity Divergence toolbar, click Plot.

Centerline Pressure
1 In the Model Builder window, right-click Centerline Velocity Divergence and choose 

Duplicate.

2 In the Settings window for 1D Plot Group, type Centerline Pressure in the Label text 
field.

3 Locate the Plot Settings section. In the y-axis label text field, type p [atm].

Line Graph 1
1 In the Model Builder window, expand the Centerline Pressure node, then click 

Line Graph 1.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type p/(1[atm]).

4 Click the y-Axis Log Scale button in the Graphics toolbar.

5 In the Centerline Pressure toolbar, click Plot.

Jet Vertical-Horizontal Asymmetry
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Jet Vertical-Horizontal 
Asymmetry in the Label text field.

3 Click to expand the Title section. From the Title type list, choose Manual.
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4 In the Title text area, type Top: Axial velocity (m/s) Middle:  Cross-stream 
velocity (m/s) Bottom: Logarithm of velocity divergence.

5 Locate the Data section. From the Dataset list, choose Study 2/

Adaptive Mesh Refinement Solutions 1 (sol5).

6 Locate the Plot Settings section. From the View list, choose New view.

7 In the Jet Vertical-Horizontal Asymmetry toolbar, click Plot.

8 Clear the Plot dataset edges checkbox.

9 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

10 Clear the Show legends checkbox.

Axial Velocity
1 Right-click Jet Vertical-Horizontal Asymmetry and choose Surface.

2 In the Settings window for Surface, type Axial Velocity in the Label text field.

3 Locate the Expression section. In the Expression text field, type v.

Selection 1
1 Right-click Axial Velocity and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Vertical+Horizontal Planes.

Filter 1
1 In the Model Builder window, right-click Axial Velocity and choose Filter.

2 In the Settings window for Filter, locate the Element Selection section.

3 In the Logical expression for inclusion text field, type (x<L4)*(z<L4)*(y<L5).

Cross-Stream Velocity
1 Right-click Axial Velocity and choose Duplicate.

2 In the Settings window for Surface, type Cross-Stream Velocity in the Label text field.

3 Locate the Expression section. In the Expression text field, type sqrt(u^2+w^2).

4 Locate the Coloring and Style section. From the Color table list, choose Prism.

Transformation 1
1 Right-click Cross-Stream Velocity and choose Transformation.

2 In the Settings window for Transformation, locate the Transformation section.

3 In the x text field, type -1.25*L4.
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4 In the z text field, type L4.

Compression-Expansion Strength
1 In the Model Builder window, right-click Cross-Stream Velocity and choose Duplicate.

2 In the Settings window for Surface, type Compression-Expansion Strength in the 
Label text field.

3 Locate the Expression section. In the Expression text field, type sign(hmnf.divu)*
log10(abs(hmnf.divu)).

4 Locate the Coloring and Style section. From the Color table list, choose GrayScale.

Transformation 1
1 In the Model Builder window, expand the Compression-Expansion Strength node, then 

click Transformation 1.

2 In the Settings window for Transformation, locate the Transformation section.

3 In the x text field, type -2*1.25*L4.

4 In the z text field, type 2*L4.

5 In the Jet Vertical-Horizontal Asymmetry toolbar, click Plot.

6 Adjust the camera to reproduce Figure 6.

Show legends on the figure and zoom extents.

Jet Vertical-Horizontal Asymmetry
1 In the Model Builder window, under Results click Jet Vertical-Horizontal Asymmetry.

2 In the Settings window for 3D Plot Group, locate the Color Legend section.

3 Select the Show legends checkbox.

4 Click the Zoom Extents button in the Graphics toolbar.

Supersonic Jet Envelope
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Supersonic Jet Envelope in the Label 
text field.

3 Locate the Data section. From the Dataset list, choose Sector 3D 1.

4 Locate the Plot Settings section. From the View list, choose New view.

5 In the Supersonic Jet Envelope toolbar, click Plot.

6 Locate the Title section. From the Title type list, choose Manual.

7 In the Title text area, type Turbulence Reynolds number at the surface Ma=1.

8 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.
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9 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

Surface 1
1 Right-click Supersonic Jet Envelope and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type hmnf.muT/hmnf.mu.

4 In the Supersonic Jet Envelope toolbar, click Plot.

Shock Diamonds Isosurfaces
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Shock Diamonds Isosurfaces in the 
Label text field.

3 Locate the Data section. From the Dataset list, choose Sector 3D 2.

4 Locate the Plot Settings section. From the View list, choose New view.

5 In the Shock Diamonds Isosurfaces toolbar, click Plot.

6 Locate the Title section. From the Title type list, choose Manual.

7 In the Title text area, type Isosurfaces: Mach number.

8 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

9 Locate the Color Legend section. From the Position list, choose Bottom.

10 Select the Show maximum and minimum values checkbox.

Surface 1
1 Right-click Shock Diamonds Isosurfaces and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type hmnf.Ma.

4 Locate the Coloring and Style section. From the Color table list, choose Prism.

Turbulence Reynolds Number
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Turbulence Reynolds Number in the 
Label text field.

3 Locate the Data section. From the Dataset list, choose Study 2/

Adaptive Mesh Refinement Solutions 1 (sol5).

4 Locate the Plot Settings section. From the View list, choose New view.

5 In the Turbulence Reynolds Number toolbar, click Plot.
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6 Locate the Title section. From the Title type list, choose Manual.

7 In the Title text area, type Turbulence Reynolds number.

8 Locate the Color Legend section. Select the Show maximum and minimum values 
checkbox.

9 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

Surface 1
1 Right-click Turbulence Reynolds Number and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type hmnf.muT/hmnf.mu.

Selection 1
1 Right-click Surface 1 and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Vertical+Horizontal Planes.

4 Select Boundaries 7, 9, 11, 13, 15, 17, 23, 25, and 28 only.

Turbulence Reynolds Number
1 In the Model Builder window, under Results click Turbulence Reynolds Number.

2 In the Turbulence Reynolds Number toolbar, click Plot.

Streamlines
1 In the Results toolbar, click 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Streamlines in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 2/

Adaptive Mesh Refinement Solutions 1 (sol5).

4 Locate the Plot Settings section. From the View list, choose New view.

5 Locate the Title section. From the Title type list, choose Manual.

6 In the Title text area, type Jet and entrainment streamlines, vertical (Top) 
and horizontal (Bottom) planes.

7 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

8 Locate the Color Legend section. Clear the Show legends checkbox.

Vertical Jet Streamlines
1 In the Streamlines toolbar, click More Plots and choose Streamline Surface.

2 In the Settings window for Streamline Surface, type Vertical Jet Streamlines in the 
Label text field.
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3 Locate the Surface Selection section. From the Selection list, choose 
Vertical Extended Plane.

4 Locate the Streamline Positioning section. From the Positioning list, choose 
On selected edges.

5 In the Number text field, type 25.

6 Locate the Edge Selection section. Click Paste Selection.

7 In the Paste Selection dialog, type 12 in the Selection text field.

8 Click OK.

9 In the Settings window for Streamline Surface, locate the Coloring and Style section.

10 Find the Line style subsection. From the Type list, choose Tube.

11 Select the Radius scale factor checkbox. In the associated text field, type 0.1.

12 Find the Point style subsection. From the Color list, choose Custom.

13 On Windows, click the colored bar underneath, or — if you are running the cross-
platform desktop — the Color button.

14 Click Define custom colors.

15 Set the RGB values to 128, 0, and 0, respectively.

16 Click Add to custom colors.

17 Click Show color palette only or OK on the cross-platform desktop.

Vertical Entrainment Streamlines
1 Right-click Vertical Jet Streamlines and choose Duplicate.

2 In the Settings window for Streamline Surface, type Vertical Entrainment 
Streamlines in the Label text field.

3 Locate the Edge Selection section. In the list box, select 12.

4 Locate the Streamline Positioning section. In the Number text field, type 75.

5 Locate the Edge Selection section. Click Paste Selection.

6 In the Paste Selection dialog, type 102 in the Selection text field.

7 Click OK.

8 In the Settings window for Streamline Surface, locate the Coloring and Style section.

9 Click Define custom colors.

10 Set the RGB values to 0, 128, and 192, respectively.

11 Click Add to custom colors.

12 Click Show color palette only or OK on the cross-platform desktop.
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Horizontal Jet Streamlines
1 In the Model Builder window, right-click Vertical Jet Streamlines and choose Duplicate.

2 In the Settings window for Streamline Surface, type Horizontal Jet Streamlines in 
the Label text field.

3 Locate the Surface Selection section. From the Selection list, choose 
Horizontal Extended Plane.

4 Locate the Edge Selection section. In the list box, select 12.

5 Click Paste Selection.

6 In the Paste Selection dialog, type 10 in the Selection text field.

7 Click OK.

8 In the Settings window for Streamline Surface, locate the Coloring and Style section.

9 Click Define custom colors.

10 Set the RGB values to 64, 0, and 0, respectively.

11 Click Add to custom colors.

12 Click Show color palette only or OK on the cross-platform desktop.

Transformation 1
1 Right-click Horizontal Jet Streamlines and choose Transformation.

2 In the Settings window for Transformation, locate the Transformation section.

3 Clear the Move checkbox.

4 Select the Rotate checkbox.

5 From the Axis type list, choose Y-axis.

6 In the Angle text field, type -90.

Horizontal Entrainment Streamlines
1 In the Model Builder window, right-click Horizontal Jet Streamlines and choose Duplicate.

2 In the Settings window for Streamline Surface, type Horizontal Entrainment 
Streamlines in the Label text field.

3 Locate the Edge Selection section. In the list box, select 10.

4 Locate the Streamline Positioning section. In the Number text field, type 75.

5 Locate the Edge Selection section. Click Paste Selection.

6 In the Paste Selection dialog, type 1 in the Selection text field.

7 Click OK.

8 In the Settings window for Streamline Surface, locate the Coloring and Style section.
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9 Click Define custom colors.

10 Set the RGB values to 0, 64, and 64, respectively.

11 Click Add to custom colors.

12 Click Show color palette only or OK on the cross-platform desktop.

13 In the Streamlines toolbar, click Plot.

Jet Asymmetry Planar Perspective
1 In the Results toolbar, click 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Jet Asymmetry Planar Perspective 
in the Label text field.

3 Click to expand the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Top: Logarithm of vorticity Middle: Temperature 
(K) Bottom: Mach number.

5 Locate the Plot Settings section. Clear the Plot dataset edges checkbox.

6 Locate the Color Legend section. Clear the Show legends checkbox.

Ma Vertical Plane
1 Right-click Jet Asymmetry Planar Perspective and choose Surface.

2 In the Settings window for Surface, type Ma Vertical Plane in the Label text field.

3 Locate the Expression section. In the Expression text field, type hmnf.Ma.

Filter 1
1 Right-click Ma Vertical Plane and choose Filter.

2 In the Settings window for Filter, locate the Element Selection section.

3 In the Logical expression for inclusion text field, type (x<L1)*(z<L1)*(y<L2).

Transformation 1
In the Model Builder window, right-click Ma Vertical Plane and choose Transformation.

Ma Horizontal Plane
1 Right-click Ma Vertical Plane and choose Duplicate.

2 In the Settings window for Surface, type Ma Horizontal Plane in the Label text field.

3 Locate the Data section. From the Dataset list, choose Surface 2.

4 Click to expand the Inherit Style section. From the Plot list, choose Ma Vertical Plane.
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Transformation 1
1 In the Model Builder window, expand the Ma Horizontal Plane node, then click 

Transformation 1.

2 In the Settings window for Transformation, locate the Transformation section.

3 Select the Scale checkbox.

4 In the y text field, type -1.

T Vertical Plane
1 In the Model Builder window, right-click Ma Vertical Plane and choose Duplicate.

2 In the Settings window for Surface, type T Vertical Plane in the Label text field.

3 Locate the Expression section. In the Expression text field, type T.

4 Locate the Coloring and Style section. From the Color table list, choose Thermal.

Transformation 1
1 In the Model Builder window, expand the T Vertical Plane node, then click 

Transformation 1.

2 In the Settings window for Transformation, locate the Transformation section.

3 In the y text field, type L3.

T Horizontal Plane
1 In the Model Builder window, right-click Ma Horizontal Plane and choose Duplicate.

2 In the Settings window for Surface, type T Horizontal Plane in the Label text field.

3 Locate the Expression section. In the Expression text field, type T.

4 Locate the Inherit Style section. From the Plot list, choose T Vertical Plane.

Transformation 1
1 In the Model Builder window, expand the T Horizontal Plane node, then click 

Transformation 1.

2 In the Settings window for Transformation, locate the Transformation section.

3 In the y text field, type L3.

Decimal Logarithm Vorticity Vertical Plane
1 In the Model Builder window, right-click T Vertical Plane and choose Duplicate.

2 In the Settings window for Surface, type Decimal Logarithm Vorticity Vertical 
Plane in the Label text field.

3 Locate the Expression section. In the Expression text field, type 
log10(hmnf.vort_magn).
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4 Locate the Coloring and Style section. From the Color table list, choose Prism.

Transformation 1
1 In the Model Builder window, expand the Decimal Logarithm Vorticity Vertical Plane 

node, then click Transformation 1.

2 In the Settings window for Transformation, locate the Transformation section.

3 In the y text field, type 2*L3.

Decimal Logarithm Vorticity Horizontal Plane
1 In the Model Builder window, right-click T Horizontal Plane and choose Duplicate.

2 In the Settings window for Surface, type Decimal Logarithm Vorticity Horizontal 
Plane in the Label text field.

3 Locate the Expression section. In the Expression text field, type 
log10(hmnf.vort_magn).

4 Locate the Inherit Style section. From the Plot list, choose 
Decimal Logarithm Vorticity Vertical Plane.

Transformation 1
1 In the Model Builder window, expand the Decimal Logarithm Vorticity Horizontal Plane 

node, then click Transformation 1.

2 In the Settings window for Transformation, locate the Transformation section.

3 In the y text field, type 2*L3.

Line 1
1 In the Model Builder window, right-click Jet Asymmetry Planar Perspective and choose 

Line.

2 In the Settings window for Line, locate the Data section.

3 From the Dataset list, choose Cut Line 2D 1.

4 Locate the Expression section. In the Expression text field, type 1.

5 Locate the Coloring and Style section. From the Coloring list, choose Uniform.

6 From the Color list, choose Black.

7 In the Jet Asymmetry Planar Perspective toolbar, click Plot.

8 Adjust camera to reproduce Figure 7.

Show legends on the figure.

Jet Asymmetry Planar Perspective
1 In the Model Builder window, click Jet Asymmetry Planar Perspective.
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2 In the Settings window for 2D Plot Group, locate the Color Legend section.

3 Select the Show legends checkbox.

Calculate maximum, minimum and average values.

Evaluation Group 1
1 In the Results toolbar, click Evaluation Group.

2 In the Settings window for Evaluation Group, locate the Data section.

3 From the Dataset list, choose Study 2/Adaptive Mesh Refinement Solutions 1 (sol5).

4 From the Parameter selection (Refinement level) list, choose Last.

Surface Maximum 1
1 Right-click Evaluation Group 1 and choose Maximum > Surface Maximum.

2 Select Boundaries 23 and 25 only.

3 In the Settings window for Surface Maximum, locate the Expressions section.

4 In the table, enter the following settings:

Volume Minimum 1
1 In the Model Builder window, right-click Evaluation Group 1 and choose Minimum > 

Volume Minimum.

2 In the Settings window for Volume Minimum, locate the Selection section.

3 From the Selection list, choose All domains.

Surface Average 1
1 Right-click Evaluation Group 1 and choose Average > Surface Average.

2 Select Boundary 27 only.

3 In the Settings window for Surface Average, locate the Expressions section.

4 In the table, enter the following settings:

5 In the Evaluation Group 1 toolbar, click Evaluate.

Expression Unit Description

hmnf.Ma 1 Mach number

hmnf.U m/s Velocity magnitude

hmnf.muT/hmnf.mu 1

Expression Unit Description

u*hmnf.nxmesh+v*hmnf.nymesh+w*hmnf.nzmesh m/s
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